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1. Introduction

IIB V10.0.0.4 introduced Callable Flows. This enables a message flow (or integration service, or
REST API) to invoke a separate message flow in a call/return (blocked wait) programming
model.

The calling and called message flows can operate on remote Integration Nodes, including 11B on
Cloud and I1IB On Premise.

1.1 Scenario Overview

This is the Development lab for Callable Flows in which you will create the applications and run a
simple local test. The artefacts are then used for two of the following labs — 11B on Cloud Callable
Flows (16L12) and Docker Callable Flows (16L11), which provide additional runtime
opportunities for the same developed applications.

In this lab, you will use the HR_Service REST API that was developed in 16L02 (Create a REST
API with a swagger document) in this series of labs.

You will add a new operation. The implementation of this operation invokes a ‘Callable’
application. The callable application will access a database and retrieve employee details.

IBM Integration Bus on Premise

IBM Integration Toolkit

HR. Service CallableApplication.
Import HR_Service

1.2 Outline of tasks

The tasks to complete in this lab are the following:

1. Import a REST API solution
2. Add an operation to the REST API to call a ‘Callable’ application
3. Import a map to access employees data
4. Create the Callable Application
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1.3 Open the Windows Log Monitor for |IB

A useful tool for 1B development on Windows is the IIB Log Viewer. This tool continuously
monitors the Windows Event Log, and all messages from the log are displayed immediately.

From the Start menu, click [IB Event Log Monitor. The Monitor will open; it is useful to have this
always open in the background.

-10/x]

BIP31321:= ¢ IB1ANODE_zerverl » The HTITP Listener has started listening on port N
'78AA° ' for ''http'’ connections. [1A/3-2014 3:17:23 PH]
BIF215%41:= ¢ IB1BNODE_zerverl » Execution group finizhed with Configuration messzal
[18-3.-2014 3:17:24 PM]
¢ IB1BNODE.szerverd > Configuration message received from broker. [18-3

/2014 5:87:36 PHM]

: ¢ IB1BNODE.zerverd » About to '’'Change’’ an execution group. [18-3-281
4 5:@7:36 PM]
BIF21551:- ¢ IB1ANODE._zerverl > Abhout to *’'create '’ the deployed resource '*Empl|
oyeeService JEOMClient’’ of type '’ _APPZIP'’. [18-3-2814 5:87:37 PM]
BIF21551= ¢ IB1BNODE_szerverl > About to ‘‘create '’ the deployed resource '‘gen.
getEmployee_EmploveeService_EmpServClient_JSON1'' of type **.SUBFLOW''. [18.3/28
14 5:87:37 PM]

: ¢ IB1BNODE.zerverd » About to ‘‘create °° the deployed resource °°EmpS
ervClient JEONL'' of type '’ . MEGFLOW'’. [18-3-2814 5:87:37 PM]
BIP21541:= ¢ IB1ANODE_serverl > Execution group finiszhed with Configuration messal
ge. [18-3-2814 5:87:43 PHM]
EIF31321:= ¢ IB1GNODE_HTTIPLiztener > The HITP Lisztener has started listening on p
ort *'7888°'°' for ‘'http’’ connections. [18-3-2814 5:87:47 PHM]
BIF21521:- ¢ IB1ANODE._zerverl > Configuration message received from bhroker. [18-3
/2014 5:58:41 PHM]

¢ IB1BNODE.zerverd » About to '’'Change’’ an execution group. [18-3-281

4 5:58:41 PM]
BIFZ21551:= ¢ IB1ANODE._zerverl > About to *‘'delete '’ the deployed resource '*EmpS

This tool is not shipped as part of the IIB product; please contact us directly if you would like a
copy.

Important note

The instructions in this lab guide are based on a Windows implementation, with a user
named “iibuser”.

The Windows VMWare image on which this lab is based is not available outside IBM, so
you will need to provide your own software product installations where necessary.

This lab prepares the artefacts for deploying a REST API and a Callable Flow
application, running on different Integration Nodes. It is assumed that one of the key
scenarios is running the REST API on 1IB on Cloud and hence the reference in this lab
as ‘Cloud Application’.

You should use the Windows user "iibuser". This user is a member of mgbrkrs and
mqgm, but is not a member of Administrators. The user "iibuser" can create new |1IB
nodes and do all required IIB development work. However, installation of the IIB
product requires Administrator privileges (not required in this lab).

The lab uses DB2 HRDB database. HRDB contains two tables, EMPLOYEE and
DEPARTMENT. These tables have been populated with data required for this lab. (The
DDL for the HRDB is available in the studentl10 folder; The corresponding DDL for
Microsoft SQL/Server is available in Integration service _SQLServer, and we intend to
provide the DDL for Oracle over time).

For the scenario, a single JSON Schema is used, which the built resources reference.
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1.4 Configure Integration Bus node to work with DB2

Note 1

Login to Windows VM Image as the user "iibuser"”, password = "passwO0rd".

Start the IIB Toolkit from the Start menu.

Note 2

If you have already done Lab 1 or Lab2 in this series (create a REST API), you can
skip straight to Import the REST API.

The HRDB database, and the EMPLOYEE and DEPARTMENT tables have already been
created on the supplied VMWare image. If you wish to recreate your own instance of this
database, the commands

1 Create HRDB database.cmd and
2 Create HRDB Tables.cmd

are provided for this. If used in conjunction with the VM image, these commands must be run
under the user "iibadmin". Appropriate database permissions are included in the scripts to
GRANT access to the user iibuser.

To run this lab, the Integration Bus node must be enabled to allow a JDBC connection to the
HRDB database.

1. Open an lIB Command Console (from the Start menu), and navigate to
c:\studentlO\Create HR database
2. Runthe command
3 _Create_JDBC_for HRDB

Accept the defaults presented in the script. This will create the required JDBC
configurable service for the HRDB database.

3. Runthe command
4 Create HRDB SecurityID

4. Stop and restart the node to enable the above definitions to be activated

mgsistop TESTNODE iibuser

mgsistart TESTNODE_ iibuser

This will create the necessary security credentials enabling TESTNODE _iibuser to connect to the
database.
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1.5 Configure TESTNODE iibuser for REST APIs

The 11B support for the REST API requires some special configuration for the 11B node and server.
Cross-Origin Resource Scripting (CORS) must be enabled for the 11B node to execute REST
applications. This is also required when testing with the SwaggerUl test tool. See
http://www.w3.org/TR/cors/?cm_mc uid=09173639950214518562833&cm_mc_sid 50200000=1452
177651 for further information.

1. Ensure that TESTNODE iibuser is started.

2. Check that CORS has been enabled on the IIB node by running the following command in an
Integration Console:

mgsireportproperties TESTNODE iibuser
-e default
-o HTTPConnector
-r

3. If CORS is enabled, you will see the following lines (amongst others):

corsEnabled="'true'’
corsAllowOrigins="'*"
corsAllowCredentials="'false'
corsExposeHeaders="'Content-Type'
corsMaxAge='-1"
corsAllowMethods='GET,6 HEAD, POST ,PUT, PATCH, DELETE , OPTIONS'
corsAllowHeaders='Accept,Accept-Language,Content-Language,Content-

Type'
4. If CORS has not been enabled, run the following commands:

mgsichangeproperties TESTNODE iibuser
-e default
-o HTTPConnector
-n corsEnabled -v true

mgsistop TESTNODE iibuser

mgsistart TESTNODE iibuser
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2. Import 1IB REST API and create new resource

In this section you will import a partially-built solution and add a new resource to the REST API to
invoke a ‘Callable’ application. The scenario is based on the HR_Service example that you may
have used in other labs in this series.

2.1 Import REST API and Shared Library

1. Open the Integration Toolkit from the Start menu with a new Workspace, for example
C:\Users\iibuser\IBM\IIBT10\CallableFlows

If you have the Integration Toolkit already open, you can switch to a new Workspace by click
on File -> Switch Workspace -> Other

& Workspace Launcher il

Select a workspace

IEM Integration Toolkit stores your projects in a folder called a workspace.
Choose a workspace folder to use for this session.

Waorkspace: IC:'|,I_Isers'|,ii|:|userH,IBM\,IIETID'l,CaIIahIEFIDws j Browse... |

. F Copy Settings

1 @:‘ ‘ ’ Cancel
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2. When the Integration Toolkit restarts, right-click in the Application Development view and
select Import. Click Next, navigate to the folder

C:\student10\CallableFlows\Resources

Select the file HR_Service_CallableFlows.zip and click Open. Confirm the import in the
next window.

Similarly, click Import again, then Next and navigate to
C:\studentl0\CallableFlows\Solution
Select the file HR_Service_Executables.zip

Once the projects are imported, you should see the REST API in the Application
Development view:

IG5 Application Development 52 | &2 Patterns Explorer = 0

E=g ¥

Application Development Mew. ..
ey

E-E
-7/ REST API Description
EILE. Resources
F-(22 Flows
+-22 Subflows
EI.‘_:,,} Maps

...... [=+ getDepartment_getDepartment.map

------ @- getEmployee_getEmployee.map

L @- getEmployeeMumber.map
#-2Y EsqLs
-5 REST API Catalog
'E Referenced Libraries
E Other Resources
I':_'I-"E'\a? HR._Service_Executables
(= Maps
- @- getEmployee]S0OMN. map
-4 REST API Catalog
@ Referenced Libraries

LH:._‘, Cther Resources
Fl-gl HRDE
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2.3 Add new resource to the REST API
1. Double-Click on REST API Description.

You will see all the resources available.

The imported solution has an operation in the /employees/ {employeeNumber} resource
implemented.

For this lab you will add a nhew resource, which will be used for the Callable Flow
implementation.

Click on the icon @ as shown.

[ HR Service & ' ¢
-

» Header

- Resources ” v a

2. In the Create Resource dialog, do the following:
e Highlight {employeeNumber}
e Give a new ‘Resource path’ - /Employee_CallableFlow
e Select operation GET

Click OK.

%

Select a path segment in the existing resource structure to create a resource under it

[=-Base path
E| J/departmenis
| B f{departmentkey}
: Jemployees
.- fmanager

mployeeMumber}

- fMQEndpoint
- jdoudODBC

- M{EDLEVEL}

. fpredictSalary

Resource path relative to the selection Ul fEmployes_CallableFlow

Select operations to add to the resource

[ rosT O put ] DELETE
| OPTIONS [ HEAD [ paTCH
@:‘ OK | Apply Cancel
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3. The new resource /employees/ {employeeNumber} /Employee CallableFlow has
been created.
Expand the resource to see its operations.
Click on the drop down menu for available ‘Schema Types’ and select ‘EmployeeResponse’.
C: [employees/{employeeNumber}/Employee_CalIabIeFlow)
GET  getEmployee_CallableFlow (Request Employee using Callableﬂow)
Name Parameter typData type Format Required Description :
employeeNumberpath | string || 2
Response stat Description Array Schema type Allow nul
|200 |The operation was successful. [ ‘[oyeeResponse ~| [~
EMPLOYEE
» femployees/{employeeNumber}/MQEndpoint BEE'EF;FT,MENT
+ [employees/{employeeNumber}/cloudODBC se
» femployees/{employeeNumber}/department Eslterzit:gilledResponse
integer
e g number
- Madel Definitions boolean
Name [Array [Type |Allow
® <Enter a ynique pame to create a new model> — . s o
You may have also noticed that you can provide your own comment for the operation. Add
‘Retrieve Employee using CallableFlow’.
Save the updated HR_Service.
4.  Scroll to the right of /employees/ {employeeNumber} /Employee CallableFlow.
You will be modifying the getEmployee CallableFlow operation so to implement it, click
. g
on the icon as shown
Retrieve Employee using CallableFlow
®
ray Schema type Allow null 0
] &
5. This will open the subflow editor with a skeleton subflow.
Input Output
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6. In the Node Palette on the left, expand the ‘Callable Flow' group. This contains three nodes,
which were introduced in 11B V10.0.0.4.

Drag and drop a hew CallableFlowInvoke node onto the flow editor as shown.
In the Properties of the CallableFlowlnvoke node, set the following properties:

e Target Application:

o HR_Service_ CallableApplication — this is the IIB application which will be
deployed On-Premise and will retrieve the employee data from the
database.

e Target Endpoint Name:
o CALLABLE_Input — Callable Input node in the Callable Application.

Bz *getEmployee_CallableFlow.subflow &
4 <t Palette | Flow Exerciser: : @ e R

TEAITANSIONmduon :I
L1 Construction
2 Callable Flow @ [} H
[ CallableInput Input
-# CallableReply

52 CallableFlowInvoke ===

L Cloud Connectors }
& LoopBack Connectors CallableFlowInvoke
‘& Matahaca ﬂ

Graph| User Defined Propertie5|

E Properties 2 5 Problems &2 Outline ¥ Tasks & Deployment Log
=2 CallableFlowInvoke Node Properties - CallableFlowInvoke
Description | _
Basic { Target Application* IHR_Senr'ice_CaIIabIeAppIicatiDn \ ﬂ
Monitori i * -
ng Jarget Endpoint Name I CALLABLE_Input ) J

Request timeout (sec) | 120

Call Preference IPrefer local calls - |
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7. From the ‘Transformation’ group in the palette, drag and drop a Mapping node before the

CallableFlowinvoke node and name it getEmployeeNumber.
Highlight the mapping node and click Browse.

Select getEmployeeNumber map and click OK.

= Elg *getEmployee_CallableFlow.subflow &3 = a8
4 4% Palette J Flow Exerciser: J @ e
1 -~
(g 5CA =
[_.ﬁ:" WebSphere Adapters
E_T'-» Routing
Input Qutput
= -
(= Transformation <o etEmIo v d
7 NETCompute CallableFlowInvoke
= Mappin / =1
PRI LI % Data Transformation Map Selection | il
“h ¥SI Transform
Graph | User Defined Properties| Filter names {7 = any character, * = any String):
| N

] Properties 53
P Select a Data Transformation Map

= Mapping Node Properties - getEmployeeNu

= {default}:getDepartment_getDepartment

< Browse... |

-

i {default}:getEmployeehumber
_Basic  Mappingroutine™ [ {defaulth:getEmplays

Validation —

————{ Transaction™ I.-'-\uhnmaﬁc LEm

Monitoring

2 HR_Service

@ -

The map getEmployeeNumber retrieves the employeeNumber element from the Local
Environment, passed on by the REST API call. The map was created as part of the starting

solution for Lab 16L09 Endpoint connectors.
8. Connect the nodes as shown.

Save the flow with Ctrl-S.

EEf HR_Service *getEmployes_CallableFlow.subflow 32 = 8
4 53 Palette J Flow Exerciser:
~
(g} 5CA
[_@ WebSphere Adapters I}

oA Input

@ Transformation it lgetEmployeeMNumber]

e NETCompute -
= Mapping
13 ¥5LTransform
Compute
@ JavaCompute

[ Construction |

CallableFlowInvoke

Graph | User Defined Properties |
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3. Create the Callable application

In this part of the lab you will create the Callable application which will be used in IIB on Cloud
Callable Flows (16L12) and Docker Callable Flows (16L11) labs.

3.1 Generate the new application and add artefacts

The Application that you will develop will use the EMPLOYEE table from the HRDB database.
This requires the HRDB Database Definition project, which represents the tables’ schemas.
This is used by the Mapping nodes that access the EMPLOYEE table.

The HRDB project will not be developed in this lab - see Lab 16L02 for details of how to do
this. In this lab the project is included in a shared library and is already in your Workspace
from the import of the solution earlier.

In addition, the map getEmployeeJSON — in Shared Library “HR_Service_Executables” uses
an existing JSON document (HR-Employee-and-Department-Services.json) which has
defined schemas to represent the input and output messages. The map getEmployeeJSON
retrieves rows from the EMPLOYEE table.

The generation of these artefacts was done in earlier labs in this series and have been
imported into the workspace. If you wish to see how they were created, please review Lab
16L09 Endpoint Connectors lab.

1. Inthe Application Development view click ‘New..’ and then ‘Start by creating an

application’.

|=1'_, Application Dev... 3

Application Development

E| HR._Service
. --FE REST API Description

: -7 Resources

'"E'i-r HR_Service_Fxecutables
gl HRDB
- BARs
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Prepare

— o
( NEL) - R -
= o

New Artifact
7 Message Flow
|E/" Message Model ...
{=r Message Map
[3f ESOL File
L:E? Dedsion Service
;ilﬁ MQ Service
45 Database Service

Quick Start
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2. Name the application ‘HR_Service_CallableApplication’.
Click ‘Finish’.

g

Create a new application —

An application is a deployable container that provides isolation at runtime. Enter a name for the new &

application.

A e |HF'._Service_CaIIabIe.ﬂ.ppIicay

@ < Back | Mext = (r Finizh I ) Cancel |
T —y

3. Right-click the new application and then ‘Manage Library references’

Application Development 52 | &2, Patterns Explorer = O
EB/gE
Application Development Mew...

P Mew J
'“I_l {NE'N. \ .::l

‘Bl HR_Service_Ewecutables @braw r@
Ll

Ei HRDE B2 Manage induded projects

=[G BARS

"5 Focus on Application
4. In the opened dialog, tick the box for HR_Service_Executables and HRDB, and then OK.

This will allow the HR_Service_CallableApplication to reference this shared library.

) Manage Library References il

Select the shared or static libraries to be referenced. Any other static libraries referenced from the selected static library will also be induded.

FT—
.
a?&’HR_SEWiEE_E)(ECLIEHES
&l HRDB

[~ Static libraries

The following static libraries will also be induded because they are referenced by the selected static libraries.

s
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3.2 Create the Callable Application’s message flow

1. Right-click HR_Service CallableApplication then New -> Message Flow.

[5G Application Development 52 | B2 Patterns Explorer = 8 Z
= E
cEB% Prepare
Mew. ..

Application Development
Select deployable resources tc

L | CallableApplicatio -
W 4 ar,
— e - Message Flow

- B
= 'EI Referenced Libraries %"Manage Library references S
B HR_Service_E tabl
Eﬁ, —SErViEE_Fxeotabies F'..ﬁManage incuded projects E? SEEETEILE
HRDE [=% Message Map
BAR st .
5 B Focus on Application ESOL File

2. Name the new message flow ‘CallableFlow’ and click Finish.

=1oix|

Create a new message flow

Select a container for the new message flow

Container: IHR_Service_CaIIabIeAppIicaﬁon j MNew...

Message flow name< ! CallableFlow| )

Flow organization

¥ Use default broker schema

Schema; I (default broker schema)

(?:' Finishﬁl(:ancel |

3. Expand the CallableFlow folder in the Palette and drop a CallableInput and
CallableReply node onto the flow editor.

From the Transformation folder, drop a Mapping node onto the editor, and name it
getEmployee Prem.

Connect the nodes as shown below.

@ HR_Service getEmployee_CallableFlow.subflow ljﬂ HR_Service_Cloud.bar *CallableFlow.msgflow B2 = 8

{ 5= Palette J Flow Exerciser: 7 J @ &
£

(o] SCA ]|
|.{j- WebSphere Adapters
&

GpRoutrg ” -
) NET \
= CallableInput = CallableReply

Transformation

[ Construction B
(=¥ Callable Flow /—
(¥ callableInput

ﬁ CallableReply /

8 CallableFlowInvoke

[ Cloud Connectors j
Graph | User Defined Properties |

getEmployee_Prel
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4. Highlight the callableInput node and on the Basic Properties, set the Endpoint
Name to CALLABLE_Input.

This Endpoint name needs to match the Target Endpoint Name that was specified in the

CallableFlowlnvoke node in the implementation for
/lemployees/{employeeNumber}/Employee CallableFlow in HR_Service (step 2.3.6).

Page 16 of 23

¢ nE Palette

(3 5CA a|

E{E WebSphere Adapters

|+ Routing
T J

Transformation

Eﬁ_ Construction
[ Callable Flow £
ﬂ-ﬂ CallableInput

J Flow Exerciser:

..ﬁ CallableReply LI

[

i

Graph | User Defined Properties |

B Properties 52 %/ Problems oF Outline 4% Tasks £

(l2 callableInput Node Properties - CallableInput

Description

Basic Endfgint Mame™ |C.-5.LL.-5.BLE_In|:|ut

Monitoring

IIB Callable Flows — Development and Basic Test
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5.  Highlight the Mapping node getEmployee Prem.

In the properties of the map node, use the Browse button to set the name of the map file to
getEmployee JSON. (Thisis a map in the HR_Service_Executables shared library that
you imported and referenced earlier in this lab).

LB Camicn Ml b E# *CallableFlow.msgflow 52 = B

4 2k Palette J Flow Exerciser: (5 J @& @

s IMS
Lz, HTTP

REST
Web Services
@_‘?E— CallableInpN /;allableReply

@WEbWE Adapters etEmIo ee Pre
Graph | User Defined Properties |

= b

] Properties i3 Tasks Deployment Log = T =8

‘= Mapping Node Properties - getEmployee_Prem

Description

Basic Mapping routine® |{default}:CaIIableFIowgetEmployee_Prem ‘ Browse. .. |
Validation
——— | Transaction™ IAummaﬁc j
Monitoring

& pata Transformation Map Selection _ ol x|
Filter names {? = any character, * = any String):

W —

< I = {default}:getEmployee]SON in Shared Library HR_Servioe_Execuiables‘)

Location:

12 HR_Service_Executables

@ OK I Cancel

6. The flowis now complete, so Save and close the flow.

E¥E *CallableFlow.msgflow 52 = B8

q 5% Palette J Flow Exerciser: &

4ms IMS

REST
[ Web Services
@:‘SCA— Callablelnput CallableReply

[-"T:‘WEbWE Adapters etEmIo ee_Prel
Graph | User Defined Properties |

i B

E Properties i3 I'o Problems DOF Outline 4= Tasks [ Deployment Log ? Y =0

i Mapping Node Properties - getEmployee_Prem

Description
Basic Mapping routine® | {default}:getEmployee]SON in Shared Library HR_Service_Executables
Validation
——— Transaction™ IAummatic
Monitoring
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4. Test the new REST APl Resource and Callable
Application

In this part of the lab a quick test will be done to make sure that your developed solution works.
Please note that in this test you will be deploying all the resources to the same Integration server.
In 11B on Cloud Callable Flows (16L12) and Docker Callable Flows (16L11) labs you will see how
you can use Callable Flows between different Nodes/ environments.

4.1 Deploy the Shared Library and the Callable Application

1. Inthe IIB Toolkit navigator, deploy first the HRDB and HR_Service_Executables shared
libraries to the default server and then the HR_Service_CallableApplication.

[5G Application Development 52 | ¢, Patterns Explorer = B
E /g v
Application Development Mew...

#-[E HR_Service
HR._Service_CallableApplication
'“E'i'? HR._Service_Execufibles
gl
-5 Baks

&5 Integr... =

m [

iln

EHEE Integratign Mgdes
Elqﬁ TE _iibuser
g, defallt
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4.2 Deploy the service

1. Inthe lIB Toolkit navigator, deploy HR_Service REST API to the default server.

Application Development &3 = H
EgE -
Application Development Mew...

=-E HR_Service

----- Tl REET API Description
-7 Refources

[+ [A] HR_Sefvice_CallableApplication
---g;:* HR_Seryice_Fxecutables
#-gl HRDB
=-I BARS

Indeperient Resources

+ [ P T R Y

+|--

5o Integr... 22 PG Integr.. ©3 DataP.. [ Datas.. =

i
[

=43 TESTMPDE iibuser
Eeﬁ. detault
E HR_Service_Callablespplication

---g;f HR._Service_Executables

EIE:E Integratiop Nodes
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4.3 Test the service

1. Open the IIB web Ul by right-clicking TESTNODE_iibuser and selecting Start Web User
Interface.

&4 Integr.. 52 %4 Integr.. T3 DataP.. [ Datas.. = 8
5]

El|m

E‘#i dEfauH: =" Mew Integration Server
@ HR._Servit

B-m HR_Servi( . StOP

£ Change

# Delete

@ Start Web User Interface

‘2 Cpen Policy Sets

2. You will be switched to the default browser. Fully expand TESTNODE _iibuser, down to the
HR_Service REST API, as shown below.

Under HR_Service, click "API", which will show you the available operations in the REST
API, and whether they have been implemented. You will be able to see a few operations that
had been implemented.

For this lab we will use Employee_CallableFlow operation, so check that you see the
operation has been implemented.

It will also show you the URLSs for the REST API and the definitions (the json file).

IBM Integration Welcome, default

Filter Options... = = ~
< |ZE| HR_Service - REST API
~ (8 TESTNODE _iibuser =r
v (= Servers
Expand all Collapse all
~ &, default
I Services REST APl Base URL hitp://betaworks-esb10:7800/HR_Services/resources :i
~ (= REST APIs @ESTAPI Definitions URL http.ﬁﬁbelawcrksresbiO.78OOEHRfSewicesﬁre5ources.e‘HRfEmp\oveefandeepartmemtﬁSeMces.JscD
v &5 HR_Senvice
] API » Idepartments
B Lib
b foranes » Idepartments/{departmentKey}
» 78 Message Flows
» 2 Subflows b Idepar P
» (= Resources
» (@l References Lt LG L
» (& Applications e
(™ Libraries
> ﬁ«' Shared Libraries > ploy {EDLEVEL }/predi Y
I Message Flows
» lemployees/{employeeNumber}
=2 Subflows —4
= Resources - ploy {employ HEmployee_C low
» (-] Operational Policy
» (= Data » GET getEmployee_CallableFlow Request Employee using Callableflow Implemented
et A Seur | .
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3. Onthe "REST API Definitions URL", right-click and select "Copy Link Location".

HR_Service - REST API COPY
=r
REST APl Base URL http:ibetaworks-esb10:7800/HR_Senicesiresources
REST API Definitions URL  http:iibetaworks-esb10:7800/HR_Senvicesiresources/HR_Employee_and_Department_Senices json
Open Link in New Tab
Open Link in New Window
» Idepartments Open Link in New Private Window
Bookmark This Link
»  Idepartments/{departmentkey’ =
£ =R } Save Link As...
—
I etswork...”

b idenartm

4. In Firefox, open a new tab, and open the SwaggerUl tool (using the bookmark in the REST
folder).

If you are using your own environment, open Swagger Ul.

By default, this will open the Petstore Swagger document.

c ‘ | Q search

D filesfc: ftoolsfswagger-ui-master fdist/index. html

Healthcare | | Registration | | Cloud | | Build | Feedback | | Mobile

1 swagger http://petstore.swagger.io/v2/swagger.json

| hoom | hmB | | was | | s

Swagger Petstore
This is a sample server Petstore server. You can find out more about Swagger at http://swagger.io or a
sample, you can use the api key special-key to test the authorization filters.

Contact the developer
Apache 2.0

5. Inthe entry field (not the browser address field), paste the contents of the clipboard and click
Explore.

The two high-level tags departments and employees, will be shown.

PASTE

1 swagger iervices/resources/HR_Employee_and_Department_Services.json Explore

HR Employee and Department Services

This is the HR Swagger document for the Employee and Department Services used by the IIB BetaWorks REST labs. It contains resource
definitions and |JSON model definitions.

departments : Lists all of the departments at ACME Show/Hide | ListOperations | Expand Operations
employees:ListsaIIoftheemployeesatACME ShowsHide | ListOperations | Expand Operations

default Sho Hide List Operations Expand Operations
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6.

7.

We are concerned with the getEmployee_CallableFlow, which is in the ‘default’ section
because the IIB Toolkit does not offer the option to provide a "tags" parameter on the new
definition.

Click "List Operations" to show the operations related to employees.

Note that SwaggerUl does not have any knowledge at this point of whether the operation has
been implemented.

1 swagger iervices/resources/HR_Employee_and_Department_Services.json Explore

HR Employee and Department Services

This is the HR Swagger document for the Employee and Department Services used by the IIB BetaWorks REST labs. It contains resource
definitions and JSON model definitions.

departments : Lists all of the departments at ACME

employees : Lists all of the employees at ACME

default Show/Hide { List Operations | Exjand Operations

/femployees/{employeeNumber}/MQEndpoint
/employees/{employeeNumber}/cloudODBC

/employees/{employeeNumber}/Employee_CallableFlow

Expand the GET employees/{employeeNumber}/Employee_CallableFlow operation by
clicking it.

The input parameter is employeeNumber. Provide a suitable value, say 000010.

default Show/Hide | ListOperations = Expand Operations

/femployees/{employeeNumber}/Employee_CallableFlow

Implementation Notes
Retrieve Employee using CallableFlow

Response Class (Status 200)
Model Schema

i
"DBResp™: {
"UserReturnCode": 8,
"RowsRetrieved”: @,
"RowsAdded": @,
"RowsUpdated": @,
"RowsDeleted": @,
"SQLCODE_Errorcode": @,
"SQLSTATE_SQLState": "string",
"SQL_Error_Message": "string" ;I

Response Content Type | application/json *

Parameters
Parameter m Description Parameter Type Data Type

employeetidgber | DDO010| path string
Try it out!
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8. When you have provided an employeeNumber, click Try it out!

If successful, the returned data will look something like this. Note the database response
information (user return code, number of rows returned), as well as the user data.

Note that you can copy the Request URL below, and paste directly into a browser.

Request URL

http://betaworks-esbl@:7888/HR_Services/resources/employees/880818/Employee_CallableFlow

Response Body

{

"DBResp": {
"UserReturnCode": @,
"RowsRetrieved": 1

Ts

"Employee™: [

{
"EMPNO": "@@aale",
"FIRSTNME": "CHRISTINE",
"MIDINIT™: "I",
"LASTNAME™: "HAAS"™,
"WORKDEPT": “A@a",
"PHONENO™: "3978",
"HIREDATE™: "1995-8l1-81Tea:ea:aei",

"JOB™: "PRES T L=
"EDLEVEL": 18,
mSEXM: MEM,

"BIRTHDATE": "1963-88-24T86:080:00+81:0808",
"SALARY": 152758,

Response Code

268

Response Headers

"content-type”: "application/json; charset=utf-8"

Now that you have completed this lab for developing Callable Flows artefacts you can
proceed to 11B on Cloud Callable Flows (16L12) and Docker Callable Flows (16L11) labs. In
these labs you will see the value of using Callable Flows in distributed environments such as
[IB on Cloud or Docker.

END OF LAB GUIDE
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